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1. Introduction

The WageReporter application is a tool that has been made available to West Virginia employers to assist with the preparation and filing of quarterly Unemployment Compensation Wage Reports.  It supports both single and multiple employer preparation and filing of both paper and electronic Floppy Disk based report submission.

This document will provide you the steps necessary to install and setup your Wage Reporter software once it is installed.  This document is also a user’s guide that will describe the basic functionality of the WageReporter Version 3 application.

2. Installation

IMPORTANT:  If you want to retain the wage data you have entered using the previous version of WageReporter, do NOT uninstall the previous version until after you have imported the data! (See section 4.)

2.1. Installation from CD

1. Insert the UC Wage Reporter installation CD into your CD ROM drive.

2. Double click on the ‘My Computer’ icon, and then double click on your CD ROM icon, causing the contents of the CD to be displayed.

3. Double click on Setup.exe and follow the instructions on the screen to complete installation of UC Wage Reporter.

4. During the early stages of the install, the following message may be displayed:

Setup cannot continue because some system files are out of date on your system.  Click OK if you would like setup to update these files now.

You will need to restart Windows before you can run setup again. Click Cancel to exit setup without updating system files.  If you click OK, the application installs the correct file. If you select Cancel, the operation stops. The setup process will not complete successfully until the correct file has been installed on the system.

5. Click OK to update the system files and continue with the setup.

5. During the install, you may encounter situations in which a file is about to be overwritten and the application will ask which file to keep.  As a general rule, it is best to keep or install the newest version of the file; the version is indicated by the dates shown for the files in question.

6. Follow the instructions on the screen to proceed with installing the application.

7. Once the software installation is complete, it is recommended that you restart your computer.

8. Create a shortcut to the Wage Reporter application by navigating to the folder in which the UC Wage Reporter application is located

“c:\Program Files\UC Wage Reporter 3”

Right click on the UCWR3.exe file and select the Create Shortcut option.

9. Click and hold the left mouse button while selecting the UCWR3.exe file and drag the file to the desktop (at which point the shortcut will appear on the desktop) - release the left mouse button.

10. Double-click the left mouse button to initiate the UC Wage Reporter application.

2.2. Installation from Web Download

1. Navigate to the location where you downloaded the “Wagerept3.exe file and double click it.  Either accept the default “Unzip to folder” or choose a new location.  Be sure to remember this location.  Click on “Unzip” to extract the files.

2. Navigate to the location of the extracted files (the “Unzip to folder”).

3. Double click on Setup.exe and follow the instructions on the screen to complete installation of UC Wage Reporter.

4. During the early stages of the install, the following message may be displayed:

Setup cannot continue because some system files are out of date on your system.   Click OK if you would like setup to update these files now. You will need to restart  Windows before you can run setup again. Click Cancel to exit setup without updating system files. 

If you click OK, the application installs the correct file. If you select Cancel, the operation stops. The setup process will not complete successfully until the correct file has been installed on the system.

Click OK to update the system files and to continue with the setup.

5. During the install, you may encounter situations in which a file is about to be overwritten and the application will ask which file to keep.  As a general rule, it is best to keep or install the newest version of the file; the version is indicated by the dates shown for the files in question.

6. Follow the instructions on the screen to proceed with installing the application.

7. Once the software installation is complete, it is recommended that you restart your computer.

8. Create a shortcut to the Wage Reporter application by navigating to the folder in which the UC Wage Reporter application is located

“c:\Program Files\UC Wage Reporter 3”

Right click on the UCWR3.exe file and select the Create Shortcut option.

9. Click and hold the left mouse button while selecting the UCWR3.exe file and drag the file to the desktop (at which point the shortcut will appear on the desktop) - release the left mouse button.

10. Double-click the left mouse button to initiate the UC Wage Reporter application.

3. Main Application Window

The application main screen is an MDI (Multiple Document Interface) container similar to Microsoft Word and Excel.  All other screens will be displayed within this main screen.  The screen contains a Menu bar, a Toolbar and a Status Bar as shown below:
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3.1. Menu Bar

3.1.1. File

The file menu has three items: Print Report, Import and Exit as shown below:
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Print Report will display the Reports Window where Wage reports can be viewed, printed or written to a Diskette.  

Import will be available when the program is first launched to allow data from a previous version of the WageReporter to be included in the new version.  Once data has been imported or entered manually, this option will no longer be available.

Exit will close the main screen along with any open child screens (Employer Maintenance, Quarterly Maintenance, Reports, etc.).  Before closing any child screen, the user will be given a chance to save any pending changes.

3.1.2. Edit

The Edit Menu item contains standard Windows Copy, Cut and Paste functions as seen below:
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3.1.3. Tools

The Tools Menu Item provides access to the “Maintenance Screens” such as the Employer Maintenance, Quarterly Maintenance and Master Maintenance screens as well as the copy data function.
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3.1.4. Report

The Report menu item provides access to the “Report Screen” where both electronic and paper based filings are generated.
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3.1.5. Window

The Window Menu shows what task windows are currently open and allow you to display any of the open windows.
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3.1.6. Help

The Help menu has one item titled “About Wage Reporter,” that displays information about the application including the version number.
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It also provides access to the Microsoft System Info utility and provides the means to email the application Log File to support personnel.  The Help About screen is pictured below:

3.2. Toolbar

Toolbar buttons are provided to allow quick access to the main functions and forms of the application.  The toolbar buttons are described below.

3.2.1. Exit

The “Exit” button closes the application and all open forms within the application.  The user will be prompted to save any pending changes.
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3.2.2. Employer Maintenance

The “Employer Maintenance” toolbar button opens the Employer maintenance screen.
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3.2.3. Quarterly Maintenance

The “Quarterly Maintenance” toolbar button opens the Quarterly maintenance screen where employee wage data is entered and edited.
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3.2.4. Reports

The “Reports” icon provides access to the Reports Screen.
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3.2.5. Master Maintenance

The “Master Maintenance” button opens the screen where Contact/Return information is entered and maintained.
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3.3. Status Bar

The status bar provides information about what the application is currently doing.  For example, if the application is waiting for or accepting user input it will display “Ready…”  While saving changes it will display “Saving…”  The Status bar also includes display of the current date and time.

4. Importing Data

The upgrade to Version 3 of the application requires that data be imported from the previous version.  This is due to changes in the format and structure of the database that were made to enhance the functionality, performance and reliability of the application.  Wage data can only be imported once and requires that no data has been input to the new application prior to the import operation.  Ideally, the import should be performed the first time you run the new version.  If you so choose, the import operation can be skipped and all wage data entered manually.

4.1. Import Operation

The import operation will be started automatically when starting the application with an empty database.  When starting the application the user will see the following prompt:
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If the user chooses “Yes” the application will navigate to the default install path for the previous version and will display a File Open dialog as seen here:
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Assuming that the previous version was installed to the default directory, the user can click on open and the data will be imported.  If the program was not installed to the default directory, the user should manually navigate to and find the “UCWageReporter.mdb” file and open it.  Once opened the application will retrieve the existing information and insert it into the new database.  As it does the user will see the following progress indication:
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Upon completion of the operation, the following confirmation will be displayed.
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If the import had been skipped, it can be activated by selecting “File / Import” from the menu Bar as long as no data has been manually entered into the program.

5. Master Maintenance

The Master Maintenance form should be completed next after importing data.  The form includes fields for entering contact and organization information.  Prior to making an entry or importing data the screen appears as pictured below:
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5.1. Entering Information

Enter the Contact information in the top portion of the window, making sure to provide all information.

If different from the Contact information, enter the Return information in the lower half of the window.  If the information is the same, click the Copy button, copying all information from the top to the bottom.

Click the appropriate button at the bottom of the form (described below).

5.2. Editing Information

Once the information has been saved it can be revised by making the appropriate changes to any of the fields and clicking on the save button.  If an entry error has been made, the data can be restored to the saved information by clicking “Cancel.”

5.3. Button Summary

· Save – Save the information that has been entered into the form.

· Cancel – If Contact/Organization information has not been previously entered and saved, Cancel clears any information entered in the fields, re-displaying a new form, awaiting input.   If data has been entered and saved, the fields will revert to the previously saved data.

· Exit – Exits the Master Maintenance function.  If there is unsaved data on the form, the user will be asked whether to save the changes.  The options are “Yes” save the changes, “No” exit without saving or “Cancel” the operation and return to the entry screen.

6. Employer Maintenance

The Employer Maintenance form is where you enter information for the employer.  If you are filing on your own behalf, much of this information will be the same as on the Master Maintenance form.  If you are preparing filings for multiple employers, an entry must be made for each employer.  The Employer Maintenance form is pictured below.
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The fields contain the following information:

Employer Number
Enter the U.C.-assigned employer account number including the check digit.

Employer Name
Enter up to 30 characters to denote the employer’s name

FEIN Number

(optional) Enter the employers Federal ID number

Date
(optional) Specify a date.  This date has no intrinsic meaning in the application and is provided for use at the discretion of the user.

Address

Enter the employer’s street address (up to 30 char)

City


Enter the employer’s city

State


Enter the employer’s state (2 alpha)

Zip Code

Enter the employer’s zip code (either 5 or 5+4)

Clicking on any Column header (i.e. “Employer Number”, “Employer Name”) will sort the data in the grid in Ascending (first click) or Descending (second click) order.  Subsequent clicks on the same column header will alternate between Ascending and Descending order.

6.1. Add Employer

To add an employer record, click on the “Add New” button at the bottom of the form.  The fields for the employer information will be cleared and made ready to enter new data.  After entering the data click on “Save” to accept the new employer record or “Cancel” to abort the operation.  Clicking cancel will clear the fields on the form.

6.2. Edit Employer

To edit an employer record, click on the appropriate row in the grid and the data will be copied into the fields below the grid.  Make any changes that are necessary..  After editing the data click on “Save” to accept the revised employer record or “Cancel” to abort the operation.  Clicking cancel will restore the fields to their original contents.

6.3. Delete Employer

To delete an employer record, click on the appropriate row in the grid.  Click on “Delete” to remove the employer record from the form.  It is important to understand that if an employer is deleted all of the employee wage data that has been entered for that employer will be permanently deleted as well.

6.4. Button Summary

· Delete – Deletes the record specified in the Employer grid only after prompting the User with an “Are you sure?” message.

· Save – Save the information entered

· Add New – Simply clears and highlights initial entry fields, directing User’s focus to initial entry.

· Cancel – Clears any information entered in the fields, re-displaying the information for the selected employer record.

· Exit – Exits the Employer Maintenance function.  If there is unsaved data on the form, the user will be asked whether to save the changes.  The options are “Yes” save the changes, “No” exit without saving or “Cancel” the operation and return to the entry screen.

7. Quarterly Maintenance

The Quarterly Maintenance form allows for the entry and maintenance of employee’s quarterly wages within the Wage Reporter application.  Provided that there is at least one employer setup within the Wage Reporter software, it is possible to enter quarterly wage information for employees pertaining to a setup employer.  After selecting Quarterly Maintenance from the Menu or Toolbar the following screen appears:
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Clicking on any Column header (i.e. “Soc. Sec Number”, “Last Name”) will sort the data in the grid in Ascending (first click) or Descending (second click) order.  Subsequent clicks on the same column header will alternate between Ascending and Descending order.

7.1. Searching

Enter the information as required on the form, namely Employer Number (or Employer Name), FEIN Number (if available), Quarter to which the report applies, and Year to which the report applies.

Once all of that information has been specified, the User must click the Search button to check and see if information has been entered for the Year and Quarter specified.

If the user has selected an employer, quarter and year that has wage data entered, the screen will look something like the one pictured below.
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Note that the Quarterly Maintenance screen also has a Status Bar at the bottom of the form.  The status bar displays the number of employee wage records entered, a running total of the wages entered and a balance remaining as compared to the Total Wages entered in the form above the grid.  The status is kept current as employees are entered, edited or deleted.

If no data was found for the given employer for the selected quarter and year the following message will be displayed:
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If the user clicks “Yes” the program will attempt to locate and display records for the previous quarter.  If no records are found for the previous Quarter the following message is displayed:
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If the user clicks “No” (see the previous dialog) the grid will be cleared and the user can either add new employee records or copy data from another quarter.  See Section 7.4 – Copy Wage Data.

Note: This operation has changed from the previous version of the program.  In order to create a copy of the data for the quarter the user must use the “copy wage data” feature described in Section 7.4 below.

7.2. Add Employees

Clicking the ”AddNew” button displays the Add Employee form (see below).
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The User must enter the information identified on the Add Employee form.  Note that it is required that the Social Security Number is added twice.  This is to help maintain the accuracy of the information entered.

7.3. Edit Employee Data

Clicking in the appropriate row and column of the grid and changing the data performs editing of employee data.  The data will be validated before being accepted.  For example, an invalid Social Security Number will be rejected if there are too many or too few digits entered.  If this occurs, a message will be displayed and the original data will be restored to the grid cell.

7.4. Copy Wage Data

Employee data can be copied from a previous quarter and used as the basis for the current quarter.  All of the employee information is copied with the exception of the wages.  When Copy Wage Data is selected from the Tools menu the following window is displayed.
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The Copy To is initially set to the current Quarter and Year and the Copy From is set to the previous quarter.  These can be changed as may be necessary.  Once the Copy From and Copy To have been selected, click on Ok to copy the wage data.  Once the data has been copied, the employee information is displayed in the grid and is ready for the user to edit the wage information.

7.5. Delete Employees

Employees are deleted by clicking the check box for the employee in the delete column of the grid.  All employees can be deleted by clicking the “Select All” button.  The employees are not actually removed until the user clicks on the “Save” button.  The check boxes can be cleared by clicking on the “Select All” button a second time.

7.6. Button Summary

· Reports – Displays the Reports form from which the User can generate a diskette or paper report for the currently selected employer.

· Save – Save the information entered – Save must be clicked in order to delete any ‘marked for delete’ entries.  If the wages are out of balance, the data will be saved but the report will be designated as a “Working Copy.”  The Words “Working Copy” will be displayed on the form and on any printed report.

· Add New – Enabled once a valid year/quarter report has been identified.

· Cancel – Clears any information entered in the fields, re-displaying a new form, awaiting input.

· Exit – Exits the Quarterly Maintenance function.  If there is unsaved data on the form, the user will be asked whether to save the changes.  The options are “Yes” save the changes, “No” exit without saving or “Cancel” the operation and return to the entry screen.

8. Reports

The reports screen provides the ability to prepare both electronic “Diskette” and paper based Wage Reports.  The report screen is shown below:
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The report grid will display all of the configured employers.  If there is only one employer, the report checkbox will be pre selected.

If any report is out of balance (i.e. the total wages entered on the quarterly maintenance screen does not match the sum of the employee wages) it will print with the words “Working Copy” below the barcode.  The reports are not to be submitted until they are correct and in balance.

Clicking on any Column header (i.e. “Employer Number”, “Employer Name”) will sort the data in the grid in Ascending (first click) or Descending (second click) order.  Subsequent clicks on the same column header will alternate between Ascending and Descending order.

8.1. Selecting the Report

Click the report column in the grid for each employer that you want a report to be prepared for.  All Employers can be selected/de-selected by clicking the “Select All” button.  The user must also select a quarter and year for the report.  The quarter and year will default to the current reporting quarter.

8.2. Diskette Option

Clicking the “Diskette” button will cause a report to be generated to floppy disk.

Place a floppy disk into the “A” drive and click “Diskette.”  If there is not a floppy in the drive, the user will be prompted to place a floppy into the drive.  If the floppy is not blank, you will be prompted to insert a blank floppy.

It is necessary that the Master Maintenance form has been properly completed and saved in order to use this option.  If it has not been completed, the user will be prompted to complete the info and the Master Maintenance form will be displayed.  Once the information has been entered and saved, the user can click on “Diskette” to resume the operation.

8.3. Print Preview

The user can preview the report(s) prior to sending it to the printer.  The formatted report will be printed to a window on the screen.  The user will have the opportunity to send the report to the printer from the preview window.

8.4. Printing

The user can send the report(s) directly to the printer without first previewing them.  The formatted report will be printed to the default windows system printer.

8.5. Button Summary

· Diskette – Generates a file on floppy disk for electronic submission.

· Print – Prints the selected report(s) directly to the default printer without performing a print preview.

· Preview – Prints the report(s) to the screen.  The report can be sent to the printer after reviewing it on the screen.

· Exit – Exits the Report function.
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